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Introduction
We can use the software Berkeley Madonna® (http://www.berkeleymadonna.com/), developed by Robert Macey and George Oster of the University of California at Berkeley, to model dynamic systems.  Dynamic systems are usually very complex, having many components with involved relationships.  For example, we can use Berkeley Madonna to model the competition among different species for limited resources or the chemical reactions of enzyme kinetics. 
	To understand the material of this tutorial sufficiently, we recommend that you do everything that is requested.  While working through the tutorial, answer Quick Review Questions in a separate document.
	In the first tutorial on Berkeley Madonna, we consider an example on unconstrained growth.  In this example, the rate of change of the population is equal to 10% of the number of individuals in the population, and the initial population is 100 individuals.  Thus, we have the following differential equation, or equation involving a derivative: 


	

	Start running the software, perhaps by double-clicking the Berkeley Madonna icon, [image: ].  A blank window will appear.  From the File menu select New Flowchart Document to obtain a flowchart window (Figure 2.1.1) in the middle panel.  With this window, we can construct a diagram model with equations.  An equations window appears, as in the left panel (Figure 2.1.2), while a parameter window (Figure 2.1.3) is on the right.
	
	
Figure 2.1.1	Flowchart window
[image: ]

Figure 2.1.2	Equations window
[image: ]
Figure 2.1.3	Parameters window
[image: ]

	The most important icons for building a model appear on the top left of the flowchart window after the selector ([image: select]) and are in Table 2.1.1.  We describe the meaning of each of these building blocks in the following sections.
Table 2.1.1	Basic building blocks of Berkeley Madonna
	Building Block
	Icon
	Meaning


	Reservoir
	[image: reservoir]
	noun, something that accumulates

	Formula
	[image: formula]
	converts, stores equation or constant, does not accumulate

	Arc
	[image: arc]
	transmits inputs and information

	Flow
	[image: flow]
	verb, activity that changes magnitude of reservoir


Reservoir
In Berkeley Madonna terminology, a reservoir, which the text and some other system dynamics software tools call a stock or box variable, is a noun and represents something that accumulates.  Some examples of reservoirs are population, radioactivity, enzyme concentration, self-esteem, and money.  At any instant, the magnitudes of the reservoirs give us a snapshot of the system.  A cylinder or drum represents a reservoir.
Quick Review Question 1 	In Berkeley Madonna, click the cylindrical reservoir icon.  Then, click towards the top-middle of the window.  What is the default name of the reservoir, displayed in red to the top and left of its icon?
	Without clicking again, type the name of the reservoir, population, which replaces the default name. If the reservoir has become unselected, click once on the reservoir and start typing to change the name.   Because a selected object is red, the contents of the window should be as in Figure 2.1.4.
Figure 2.1.4	Contents of window after insertion of reservoir called population
[image: ]
Quick Review Question 2	Click on the reservoir's name, "population", and attempt to drag the name around the screen.  Describe where the name can be dragged.

	Under the File menu, select Save Model (or ctrl-s on a PC or command-s on a Macintosh) to save your work.  Use a meaningful name for the file, such as BerkeleyTutorial1.  Save your work frequently.  Thus, if there is a power interruption, you will not lose much of your work.  Also, sometimes if you make a mistake, it is easier to close the file without saving and open the recently saved version.  Upon saving the first time, Berkeley Madonna opens a Globals window.  Click on the Flowchart tab to return to the original window. 
Flow
While a reservoir is a noun in the language of Berkeley Madonna, a flow is a verb.  A flow is an activity that changes magnitude of a reservoir.  Some examples of such activities are births in a population, decay of radioactivity, formation of an enzyme, improvement of self-esteem, and growth of money.  The flow icon represents a directed pipe with a spigot and flow regulator.
	Click on the flow icon. Starting a couple of inches to the left of the reservoir, click and drag to the right over the reservoir until a rectangular surrounds the reservoir icon.  With the flow still selected, type its name, growth.  After clicking elsewhere, the diagram should appear as in Figure 2.1.5.
Figure 2.1.5	Diagram after addition of growth flow
[image: ]
Quick Review Question 3	Drag the population reservoir around the right of the screen.  What happens to the flow arrow?
	If moving the population reservoir does not result in the flow arrow moving, too, you need to attach the flow to the reservoir.  Drag the infinity symbol at the arrowhead over the reservoir until a green rectangle surrounds the reservoir.  Perform the task of Quick Review Question 3 again.  
	Save your work.
Formula
We can use a formula, which the text and some system dynamics tools call a converter or variable, to modify an activity.  A formula can store an equation or a constant.  For example, with the population model, a formula might store the constant growth rate, say 10% = 0.1.  
	As an example for radioactive decay, radioactive substance bismuth-210 decays to radioactive substance polonium-210.  With A representing the amount of bismuth-210 and B the amount of polonium-210, the ratio B/A is significant in the model of decay.  A formula diagram component can store this ratio.
	Drag the formula icon, which is a sphere, below and to the left of the flow growth.  Alternatively, select the formula icon and then click on the desired location in the flowchart window.  Name the formula growth rate.  Blanks are permissible.  The diagram should appear as in Figure 2.1.6.
Figure 2.1.6	Diagram after insertion of formula growth rate
[image: ]
Arc
An arc, which we call a connector or arrow in the text, transmits an input or an output.  For example, in a population model, an arc can transmit the growth rate value from the growth rate constant to the growth flow.  
	In a radioactive decay model, arcs from the bismuth-210 (A) reservoir and from the polonium-210 (B) reservoir to a formula for the ratio of B over A transmit the respective amounts of radioactivity for use by the formula.
	In the population model, both the growth rate and the current population affect the current growth.  For example, if the growth rate is higher, so is the growth.  Moreover, a larger population exhibits a greater change in population.  We indicate these relationships by connecting the growth rate formula and the population reservoir to the flow growth.  Select the arc icon, click on the growth rate sphere and drag until the sphere on the growth flow turns green.  A control point appears as a small square towards the middle of the arc.  Drag this control point out and to the side to obtain a curved arc as in Figure 2.1.7a.  Using the same tool, connect population to growth as in Figure 2.1.7b.
Figure 2.1.7	Arcs drawn to growth flow
	a
	b

	[image: ]
	[image: ]


Quick Review Question 4	What happens to the arc as you drag around the reservoir or the small sphere on the flow?
	Save your work.
Removing a Component
To remove a component from the diagram, we select the component and use del on the right, top of the Flowchart window or Cut (or its shortcut) from the Edit menu.  Using the delete key on a reservoir or formula removes the component's name but does not eliminate the item from the model.    
[bookmark: OLE_LINK3]Quick Review Question 5	Click the population reservoir, and use del.  What happens to the diagram?
Quick Review Question 6	Click the arc from growth rate to growth.  What happens if you press the delete key?
Quick Review Question 7 	How do you delete this arc?
Quick Review Question 8	Select the growth flow, and press the delete key.  What happens?
	After pressing the delete key and clicking elsewhere, we obtain the message, “Can not change name from growth rate to  because Name must consist of at least one character.”  Click OK to restore the name. 
	When we remove a component, the process eliminates the item and all connected arcs and flows.  Restore the model to its previous form by closing the current document without saving and reopening the document.  If a component is missing, recreate the model to appear as in Figure 2.1.7b.
Equations and Initial Values
We are now ready to enter equations and initial values.  To begin defining an initial population, double-click the population reservoir and view a popup menu as in Figure 2.1.8.  For an initial population of 100 bacteria, type 100.  The value replaces the question mark after "INIT population =." Click OK.
Quick Review Question 9	How does the appearance of population change on the diagram?
Figure 2.1.8	Popup menu after double-clicking population reservoir
[image: ]
Quick Review Question 10	To establish the growth rate as 10% = 0.1, first, double-click the formula growth rate.  What name does Berkeley Madonna give for the formula?
	Type 0.1 in place of the question mark after "growth_rate =," and then click OK.  Notice that after entering a growth rate and an initial population, the question marks no longer appear in the sphere and cylinder, respectively.
	For equations, Berkeley Madonna uses an underscore in place of a blank in a name.  Thus, "growth rate" in a diagram (see Figure 2.1.7) becomes "growth_rate" in a Berkeley Madonna equation (see Required Inputs of Figure 2.1.9).  We employ such replacement of blanks with underscores in the text and tutorials to avoid confusion with component names.
Figure 2.1.9	Popup menu for growth
[image: ]

	Unlike growth_rate, the flow growth is not a constant; but the growth in the population changes with time as the population changes.  For our example, at any instant, the rate of change in the population, or growth, is 10% (growth_rate) of the current population (population).  In calculus terminology, the instantaneous rate of change of population is the derivative of population with respect to time t, so that we have the following formula:


	
Quick Review Question 11	The submenu Required Inputs (Figure 2.1.9) lists the items that have arcs to growth, namely population and growth_rate.  We include these variables in the formula for growth.  For our example, this instantaneous rate of change of population is 0.1population bacteria per unit of time.  Using * for multiplication and double-clicking on the appropriate variables in Required Inputs, enter the formula for growth.  What is the resulting formula?  Click OK.
	The flow growth is a biflow, which indicates that values can go in both directions through the flow, into and out of population.  Moreover, Berkeley Madonna allows population to take on positive, negative, or zero values, unless we indicate otherwise.  To restrict population to be positive, we double-click the population icon in the flowchart, and check the box “Limit value >= 0” at the bottom left of the resulting popup menu (Figure 2.1.8).
	Equation Set 1 displays the contents of the equations window in the left panel.  On the model, we had established a value for growth_rate (0.1), an initial value for population (100), and the equation for growth (growth_rate * population).  The variable t indicates time, and "d/dt (population)" is the symbol for the derivative of population or the instantaneous rate of change of population with respect to time t.  Thus, according to the formula, the rate of change of population with respect to time is growth.  As we discuss in detail in Module 2.2 on "Unconstrained Growth," this equation indicates the population at one time step is the population at previous time step plus the change in population over the time interval for one step, DT:

	(new population)	= (old population) + (change in population)
					= (old population) + growth * DT
					= (old population) + (growth over 1 unit) * (length of time step)
Equation Set 1	Formulas
{Top model}

   {Reservoirs}
   d/dt (population) = + growth
      INIT population = 100

   {Flows}
   growth = growth_rate * population

   {Functions}
   growth_rate = 0.1

   {Globals}
   {End Globals}


	Save your work and continue saving frequently.   
Parameters
[bookmark: OLE_LINK5]The top of the parameters window (in the right panel) now appears as in Figure 2.1.10.  (If the window does not appear as in in the figure, from the Parameters menu, unselect Parameters Window and then re-select Parameters Window.)  Have the simulation run for 100 time units by clicking once on the STOPTIME line and typing 100 in the text box at the top.  
Figure 2.1.10	Parameters window
[image: ]
Quick Review Question 12	What symbol now appears by the value of STOPTIME?

	If we are modeling the growth of a population of bacteria, the time unit would probably be an hour; while for a larger animal, the unit might be a month.  Suppose the model is for a colony of bacteria with an understood unit of time of one hour (hr).  
	Change DT to 0.1.  Thus, calculations for the simulation will be every 0.1 hr instead of every 0.02 hr.  Usually, a smaller DT generates more accurate results but causes the simulation to take longer.  Although the computations take longer, we can also obtain better results with the Runge-Kutta 2 or the Runge-Kutta 4 integration method than Euler’s method.  For the time being, choose the integration method to be Euler's Method from the dropdown menu (at the top of the parameters window) containing three dots,[image: ].  Chapter 6 on "Simulation Techniques" discusses these methods.
Comments
[bookmark: OLE_LINK6]Documenting our work is extremely important.  We want other people to be able to understand the model as quickly as possible.  Moreover, we can very easily forget what we intended just a few days or hours ago.  We may have several very similar versions of the same model that we need to distinguish one from another.  We do not want to waste our own or someone else's time by having to dig deeply into the different windows and equations to understand the model.  To enter a one-line comment in a flowchart, click the T icon to get a text box.  Click towards the top middle of the window to insert the text box.  Type "Growth Population Model" on one line.  The delete key and insertion work as expected.
Quick Review Question 13	Press RETURN.  Does the text box continue to a new line?
	 Type your name and date in new text boxes below your title.  
Quick Review Question 14	With the T icon selected, move the cursor over the title text box.  Give the shape of the cursor.
[bookmark: OLE_LINK7]	Still using the text feature, click at the first of the title text box and insert "Unconstrained " so that the box now reads "Unconstrained Growth Population Model".  We can also use the T icon to edit a component's name.  To leave the text mode, we choose another icon, such as select, which is second from the left.
	For longer comments, from the Model menu, select the multiline icon, TT, which is to the right of the T icon.  Type an explanation that the model is for growth of a population with no limiting factors in the multiline window, which on initial placement is a square.  Drag the bottom right corner to resize the window, and drag on a side to move the box without resizing.  
Graphs
We can now run the simulation in several ways, such as clicking the Run bottom at the top of the parameters panel, clicking the run ([image: ]) icon at the top left of the flowchart window, selecting Run Model from the Model menu, or using the shortcut indicated by this selection.  A graph popup window with a plot of population versus TIME (Figure 2.1.11) appears immediately.
Figure 2.1.11	Plot of population versus time using the default run specifications
[image: ]
Quick Review Question 15	From the Graph menu, select Choose Variables… or double-click in the middle of the graph.  What variable does the popup menu indicate for the Y-Axis?
	Also, graph growth by selecting this variable on the left and clicking Add >> or by double-clicking growth.  The resulting choose-variables popup menu is as in Figure 2.1.12.  Click OK.  For the plot to display, run the simulation again.  So that we can easily identify each plot, click the Legend icon ([image: ]) at the top of the window.  We can eliminate a variable from a graph by selecting Choose Variables… and removing the variable’s name from the Y-Axis list in one of two ways:  1.) Click on the variable in the Y-Axis list and then << Remove or 2.) Double-click the variable in the Y-Axis list.
Figure 2.1.12	Choose-variables popup menu
[image: ]
[bookmark: OLE_LINK10]Quick Review Question 16	How many time steps (DT's) does the simulation run?
	We can specify axes scales and labels in one of two ways:  by selecting Axis Settings... from the Graph menu or by double-clicking in the graph's margin.  In the axis-settings window, if necessary, click the Labels tab to view a display as in Figure 2.1.13, Uncheck the Default checkbox.  After "TIME", type “ (hr)” so that the graph will have the time units at the bottom.  Click OK.
Figure 2.1.13	Axis-settings window, Labels tab, for graphs of population and growth
[image: ]


	We can print the graph by selecting Print Graph... from the File menu.  From the File menu, also, select Save Graph..., and save the graph under the name "BerkeleyTutorial1 Graph1."  
	To preserve this graph regardless of what other changes we make, we can click the Lock icon ([image: ]), second from the left at the top of the graph window (Figure 2.1.11).  However, for this tutorial, leave the graph unlocked.
[bookmark: OLE_LINK8]Quick Review Question 17	To have Berkeley Madonna graph only population with respect to time, click the growth button on the bottom left of the graph window.  Describe changes to the graph.  Afterwards, restore the graph to its original form by clicking the growth button on the bottom left.
[bookmark: OLE_LINK14]	By double-clicking on the graph margin or selecting Axis Settings… from the Graph menu, once more reveal the axis-settings window.  If necessary, select the scales tab so that the window appears as in Figure 2.1.14.  Uncheck the Auto checkbox for the X Axis and change the specifications to plot population and growth from 0 to 5 hours.  Click OK.  The ranges in the resulting graph in Figure 2.1.15 are such that the graphs appear almost horizontal at 0.
[bookmark: OLE_LINK13]Figure 2.1.14	Axis-settings window, scales tab, for graphs of population and growth 
[image: ]
Figure 2.1.15	Graph of population and growth versus TIME 
[image: ]

	By using the axis-settings window, we can also separate the scales for population and growth.  Under the labels tab, uncheck default.  Then, change the Left Y Axis to be population, while the Right Y Axis is growth.
Quick Review Question 18	Describe how to change the scale for population to be from 0 to 150.
	Change the range of population to be from 0 to 150 with 5 divisions, so that tick marks appear every 30 units of population.  Also, adjust growth’s range to be from 0 to 19 with 19 divisions, so tick marks appear every one unit of growth.  Without re-running, the graph immediately reflects the scale changes.
Quick Review Question 19	Notice that we still cannot see the entire population graph from times 0 to 5.  Adjust the range for population by tens so that the entire graph displays for times 0 to 5.  What is this maximum to the nearest 10 (160, 170, 180, etc.)?  
Quick Review Question 20	Describe the effect of unselecting the Grid icon that has three rows and four columns of rectangles ([image: ]).
Quick Review Question 21	Instead of all plots on the same graph, we can employ separate graphs.  From the Graph menu, select New Graph.  How can we have this graph plot population?
Tables
Besides a pictorial view, we may want a table of values from the simulation.  Make a copy of the first graph window, which contains the plots of population and growth, by selecting Duplicate Graph under the Graph menu.  On the new graph window, click the Table icon ([image: ]).  The top of the resulting table appears as in Table 2.1.2.  As with a spreadsheet, we can drag a line separating column headings to the right or left to provide more or less room, respectively, for a column.
[bookmark: OLE_LINK11][bookmark: OLE_LINK12]Table 2.1.2	Table window
[image: ]
Quick Review Question 22	About how many hours does it take for the initial population to double? 
	In the case of a large table where DT is small, we may not want a list of values at every step of the simulation.  The current value of DTOUT, 0, indicates to display values every step of the simulation.  To display values every 10 simulation hours, we set DTOUT to 10 in the parameter window.  (To do so, click on DTOUT in the parameters window, click in the small text box on the second line of this window, and type 10.)  With DTOUT selected, pressing Reset restores the parameter’s original value.  Run the simulation using this setting.  
Quick Review Question 23	How many rows of values appear in the table?
	From the File menu select Save Table..., and save the table using a name such as "BerkeleyTutorial1 Table1."  Because Berkeley Madonna saves the table as "tab delimited text (*.txt)" or as "comma separated values (*.csv)," you can open the file with word processing or spreadsheet software, respectively.  Save the data in .csv format; open the resulting fine; and type your name at the top.  Afterwards, select DTOUT in Berkeley Madonna's parameters window; and press Reset to reestablish the default value of 0, which indicates output should occur at every time step.
Sliders
We can change initial values and constants in the model by using the parameters window.  In running our model for several situations, this process is tedious.  However, sliders can help us perform an assortment of simulations quickly and view the results readily.  A slider allows us to drag a slider bar to change a variable's value or click to increment or decrement by a designated amount.  From the Parameters menu, select Define Sliders to obtain the popup menu of Figure 2.1.16.   
Quick Review Question 24	In the define-sliders popup menu, give two ways to move growth_rate to the list of sliders.
Figure 2.1.16	Define-sliders popup menu
[image: ]


	Figure 2.1.17 shows the window after designating that the slider bar for growth_rate has a minimum of 0, maximum of 0.3, and changes in increments/decrements of 0.01.  Fill in the values and click OK.  Your systems now should display a slider as in Figure 2.1.18.  Viewing the graph of population versus time, drag the slider bar and observe the impact on the graph.  Alternatively, click the blue arrows to adjust the growth_rate in increments/decrements of 0.01.
Figure 2.1.17	Defining a growth_rate slider
[image: ]
Figure 2.1.18	Slider for growth_rate
[image: ]
Quick Review Question 25	Click the arrows to the left of the slider bar to change the value of growth_rate to 0.03.  Give the approximate population, rounded to the nearest whole number, at 100 hr.

	Save and quit Berkeley Madonna.
Reference
Berkeley Madonna.  1017.  http://www.berkeleymadonna.com (Accessed August 25, 2017)
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